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Welcome

Your Epson Stylus® Photo 1400 is a full-featured, wide-format photo printer.
With its exceptional speed and print resolution, you can print superior
photographs and enlargements and use it for all of your everyday printing. It
provides you with these advanced features:

B Claria™ Hi-Definition ink for the ultimate combination of photo quality and
longevity

B Smooth gradations and sharp detail with Epson’s patented MicroPiezo® print
head and DX5 technology

Automatic photo correction when printing from Windows®

True BorderFree® frame-ready prints on select 4 x 6, 5 x 7, 8 x 10, letter-size,
11 x 14, 11 x 17, 13 x 19, and even 12 x 12 scrapbook-size papers

CD and DVD printing on ink jet-printable CDs and DVDs
PictBridge™ or USB DIRECT-PRINT™ printing directly from your digital

camera or camera phone

Exif Print

The Exif (Exchangeable Image File) Print format includes information about your
digital camera settings in JPEG/TIFF files so your printer and application can use
them to create accurate print settings. Most digital cameras store Exif Print
information such as shutter speed, metering, flash, exposure settings, resolution,
and lens use in the JPEG/TIFF image file. Your printer uses the information to
ensure the most accurate image reproduction.
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About Your Documentation

To set up your printer and install its software, see the Start Here sheet.

This book contains instructions on loading paper, printing with Windows and
Macintosh® printing borderless photos, printing on CDs and DVDs, direct
printing from a digital camera or camera phone, maintaining your printer, and
solving basic problems.

For more information about your printer, see the on-screen Reference Guide by
double-clicking the icon for it on your desktop.

Please follow these guidelines throughout:

Warning:
Warnings must be followed carefully to avoid bodily injury.

Caution:
Cautions must be observed to avoid damage to your equipment.

Note:
Notes contain important information about your printer.

Tip:
Tips contain hints for better printing.
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Printing from Start to Finish

Follow the steps in these sections to load paper, CDs, or DVDs, and print from
your computer, digital camera, or camera phone.

“Loading Paper” below

“Printing with Windows” on page 14
“Printing with a Macintosh” on page 18
“Selecting the Correct Paper Type” on page 21
“Printing Borderless Photos” on page 23
“Printing on CDs and DVDs” on page 30

“Direct Printing from a Digital Camera or Camera Phone” on page 42

Loading Paper

The type of paper you choose affects the way your printout looks, so be sure to
select the correct paper for your job. For the best results, you’ll want to use one of
Epson’s special ink jet papers designed for your printer. For guidelines, see page 10.

1. Open the paper support and slide out its extensions.
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2. Open the front flap, then pull out the output tray and its extension.

Release button
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4. Insert the paper, printable side up, against the right edge guide and behind the
tab. The printable side is usually whiter or glossier than the other side.

Larger paper Tab Smaller paper Tab

Always load the short
edge first, even for
landscape printing.

You can load about 120 sheets of plain paper. (See page 13 for capacity
guidelines on special paper, such as photo or matte paper.)

5. Press in the release button on the left edge guide and slide the guide against
the left edge of the paper (but not too tightly).

Larger paper Smaller paper

Note:

The left edge guide moves slightly during paper handling and printing. Do not
adjust the guide if it moves.
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Follow these guidelines when loading paper:

B Don't load paper above the arrow mark on the left edge guide. Make sure the
paper is under the tabs on the left and right edge guides.

B Load the printable side face-up. It’s often glossier or whiter than the other
side.

Always load the short edge first, even when printing in landscape mode.
Load letterhead or preprinted paper into the printer top edge first.

If you experience paper feeding problems, try loading fewer sheets.

If youre using special paper, check the package for additional instructions on
loading and using the paper.

Special Papers

You can achieve good results with most types of plain bond paper. Coated papers,
however, provide superior printouts because they absorb less ink. Epson provides
special papers that are formulated for the ink used in Epson ink jet printers and
recommends these papers to ensure high-quality results.

Note:
When you use special paper, check the package for special instructions on loading and
using the paper.

Caution:
If your Epson® special paper includes a cleaning sheet, don't use it with this printer; the
sheet may jam inside your printer.

Epson offers the following special papers for the Epson Stylus Photo 1400:

Part
Paper name Size number

Epson Ultra Premium Photo Paper Glossy Borderless 4 x 6 inches S041934

Epson Ultra Premium Glossy Photo Paper Letter (8.5 x 11 inches) S041935

Epson Premium Photo Paper Semi-gloss Borderless 4 x 6 inches S041982

Epson Premium Semigloss Photo Paper Letter (8.5 x 11 inches) 5041331

Super B (13 x 19 inches) S041327
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Part

Paper name Size number

Epson Premium Photo Paper Glossy Borderless 4 x 6 inches S041808

Epson Premium Glossy Photo Paper S041727

Borderless 5 x 7 inches S041464

Borderless 8 x 10 inches S041465

Letter (8.5 x 11 inches) S041286

S041667

Borderless 11 x 14 inches | S041466

US B (11 x 17 inches) S041290

A3 (11.7 x 16.5 inches) S041288

Super B (13 x 19 inches) S041289

Epson Photo Paper Glossy Borderless 4 x 6 inches S041809

Epson Glossy Photo Paper S042038

S041134

S041671

Letter (8.5 x 11 inches) S041141

S041649

S041271

S041272

US B (11 x 17 inches) S041156

Super B (13 x 19 inches) S041143

Epson Bright White Paper Letter (8.5 x 11 inches) S041586
Epson Premium Bright White Paper

Epson Premium Presentation Paper Matte | Borderless 8 x 10 inches S041467

Epson Matte Paper Heavyweight Letter (8.5 x 11 inches) S041257

Borderless 11 x 14 inches | S041468

A3 (11.7 x 16.5 inches) S041260

Super B (13 x 19 inches) S041263

Loading Paper
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Part

Paper name Size number
Epson Premium Presentation Paper Matte | Letter (8.5 x 11 inches) S041568
Double-sided

Epson Double-Sided Matte Paper

Epson Ultra Premium Presentation Paper Letter (8.5 x 11 inches) S041341

Matte

Epson Enhanced Matte Paper A3 (11.7 x 16.5 inches) S041343

Super B (13 x 19 inches) S041339

Epson Presentation Paper Matte Letter (8.5 x 11 inches) S041062
Epson Photo Quality Ink Jet Paper Legal (8.5 x 14 inches) S041067
US B (11 x 17 inches) S041070

Super B (13 x 19 inches) S041069

Epson Ultra Premium Photo Paper Luster Letter (8.5 x 11 inches) S041405

Epson Premium Luster Photo Paper A3 (11.7 x 16.5 inches) S041406

Super B (13 x 19 inches) S041407

S041604
Epson Iron-on Cool Peel Transfer paper Letter (8.5 x 11 inches) S041153
Epson Iron-On Transfer Paper
Epson Photo Quality Self Adhesive Sheets | A4 (8.3 x 11.7 inches) S041106

You can purchase genuine Epson ink and paper from an Epson authorized reseller.
To find the nearest reseller, call 800-GO-EPSON (800-463-7766). Or you can
purchase online at www.epsonstore.com (U.S. sales) or www.epson.ca (Canadian
sales).
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When loading Epson special papers, follow these capacity guidelines:

Paper name

Loading capacity

Epson Presentation Paper Matte

A3 or larger sizes:

Epson Ultra Premium Glossy Photo Paper

Epson Photo Quality Ink Jet Paper 50 sheets
Smaller sizes:
100 sheets

Epson Bright White Paper 80 sheets

Epson Premium Bright White Paper

Epson Ultra Premium Photo Paper Glossy 20 sheets

Epson Premium Photo Paper Glossy
Epson Premium Glossy Photo Paper
Epson Premium Photo Paper Semi-gloss
Epson Premium Semigloss Photo Paper
Epson Photo Paper Glossy

Epson Glossy Photo Paper

Epson Ultra Premium Presentation Paper Matte
Epson Enhanced Matte Paper

Epson Premium Presentation Paper Matte
Epson Matte Paper Heavyweight

Epson Ultra Premium Photo Paper Luster
Epson Premium Luster Photo Paper

A3 or larger sizes:
10 sheets

Smaller sizes:
20 sheets

Epson Premium Presentation Paper Matte Double-sided
Epson Double-Sided Matte Paper

Epson Iron-on Cool Peel Transfer paper

Epson Iron-On Transfer Paper

Epson Photo Quality Self Adhesive Sheets

One sheet

Loading Paper
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Printing with Windows

Follow the instructions in this section to print a basic document or photo. For
instructions on printing borderless photos, see page 23. For more advanced
printing instructions, see your on-screen Reference Guide.

1. Open the File menu and select Print. You see a print window like this one:

General

Select Printer
8 Add Printer
%} EPSOM Stylus Photo 1400 Series

=i Fax
@ Microsoft XPS Document Writer

Select your printer here

Click here to open

Status: Ready [ Prirt to file | Preferences .
Location your printer software
Comment:
Page Range
@A Mumber of copies: 1 $
Selection Currert Page
©) Pages: 1-65535 Collate | I
Erter ether a single page number or a single _1'g _2'2 _3'3

page range. For example, 5-12

2. Make sure EPSON Stylus Photo 1400 Series is selected.

3. Click the Properties or Preferences button. (If you see a Setup, Printer, or
Options button, click it. Then click Properties or Preferences on the

next screen.)
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4. On the Main tab, select the basic print settings:

Select the type of document you're printing

Printing Preferences

A Main |Qij Page Layout I(@ Maintenance‘
1
Quality Optian
s 4 4 r=
=
= = [
() Draft ¢ ) TewtkImage ) Photo () Best Phato
Select
Sheet Paper Options Print Options Select
PhotoEnh, ™

Source: Sheet v [ Borderless I& PhOtOEnh?nce
Select your — [ Reverse Order to automauoally
paper Type Type:  Plain Paper / Bright ‘White Paper - [ Print Preview correct photos

Sizer Letter[31/2x1110n) -

Select your
paper Size Ink Levels Origntation

E = - _ =1

i - R R - e fPortrait

] ] ’ ] andscape
Select your
document Click here
or image Reset Defaults Orline Suppoit for more
orientation options

[ ok [ Caced |[ Hep |

Select from these Quality Option settings:

Draft: For rough drafts with reduced print quality

Text: For text-only documents with higher text quality

Text & Image: For documents with text and images with higher quality
Photo: For photos and graphics with good quality and speed

Best Photo: For photos or graphics with high print quality

Select Sheet as the Source setting.

Make sure the paper Type and Size settings match the paper you've loaded in
the printer. See “Selecting the Correct Paper Type” on page 21.

Select the direction you want your image or document to print as the
Orientation setting. Select Portrait for vertical orientation or Landscape for
horizontal.

Select PhotoEnhance to automatically correct your photos.

Printing with Windows
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9. For more printing options, click the Advanced button. Then select the
following settings as necessary.

Select a color management method
(To choose No Color Adjustment, click ICM first)

/=) Printing Preferenci- M

(ﬁ Main |Q3j Page Layout I @ Maintenance|
Select Paper & Ouality Paper & Quality Options Enlnr td anagement l
Obti Sheet ~+ [ Borderless @ Color Controls Gamma
ptions as necessary
() PhataErh, 18 -
Ultra Premium Photo Paper Glogsy  w — \CI‘: oErnance
Select Photo RPM Photo AP v
1 Color Mode | EPSOM Wivid -
for tlhe best print Letter (81722 11in) -
quality on certain _
Orientation
paper types © Lo
() Landscape . +
Biightress |+ 0 i T
Print O ptians
Select Print Options B Reyerse Dider Cophrast [+0 | ¥
as necessary Saturation |+ 0 L &
High Speed Cpan © |+0 . T
] Girapscale
Edge Smoathing Magenta @ [+ 0 ' U
[T Prirt Preview Yelow © +0 "
Eustom Seltings e [T Show this screen first
Beset Defaults Online Support

[ ok ][ Cancel ][ Hep |

Note:
When you select Photo RPM for the highest print quality, printing will take longer.

For more information about advanced settings, or instructions on saving them as a
group so you can reuse them later, click the Help button or click the ? button and
then click on the area you need help with.

10. If you want to change the layout settings, click the Page Layout tab and
select settings as necessary.

11. Click OK to save your settings, then click OK or Print to start printing.
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During printing, the following window appears and shows the progress of your
print job. You can use these buttons to cancel, pause, or resume printing. You can
also see an estimate of your ink levels.

Click to pause or
resume printing

Tip:

T e =
EPSON ...

e

Remaining 0 sec
Page0/1

Media Type : Plain Paper / Bright White Paper -
Paper Size : Letter (3172 111n) -

Ink Levels

TO734

Online Suppart

pCe

T0741 TO795 TO796 T0793 TO7a2

Tips

I

|
Pauss S| Buy Epson Ink H

] [

For great 1esuks, make sure you use genuine Epson ink

catidges.

SN -

Click to cancel printing

LCHCK to purchase ink

You can also press the @@ paper button on your printer to cancel printing.

Selecting Default Settings

When you change the printer settings within a program, they only apply to that
program. If you want to change the default printer settings for all your Windows
programs, follow these steps:

1. Right-click the @ printer icon in the lower right corner of your screen

(taskbar).
2.
3.

Select Printer Settings.

Select the default settings you want for all your applications, then click OK.

You can still change the printer settings in your individual programs, when

necessary.
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Printing with a Macintosh

Follow the instructions in this section to print a basic document or photo. For
instructions on printing borderless photos, see page 23. For more advanced
printing instructions, see your on-screen Reference Guide.

1. Open the File menu and select Page Setup. You see the Page Setup window:

Settings:

Format for:

Paper Size:

Orientation

Scale:

Page Attributes | :]
Select Stylus
[‘Stylus Photo 1400 | e Photo 14};0
""US Letter [s—+— Select your Paper Size

8.50in x 11.00 in

= Select your document
18] [18] —————7— or image orientat
or image orientation

100 %

@

>N

Select Stylus Photo 1400 from the Format for pop-up menu.

Select your Paper Size. For borderless printing, select a paper size with the

Sheet Feeder - Borderless option. See page 23 for details.

b

Click OK.

oW

Select [1#] portrait or [ landscape as the Orientation setting.

Open the File menu and select Print. You see a window like this one:

Printer:

Presets:

Select Stylus

" Stylus Photo 1400

ar

Photo 1400

" Standard

| Copies & Pages

ar

ar

Select Print Settings

Copies: 1 @Col\ated
Pages: (@ All
CFrum' 1 to: 1
Q) ( PDFv ) [ Preview ) ( Supplies... ) ( Cancel ) @

7. Select Stylus Photo 1400 from the Printer pop-up menu.

8. Select Print Settings from the pop-up menu.
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Note:
In certain programs you may need to select Advanced before you can select Print
Settings.

9. Select the following Print Settings as necessary:

10.

ar

ar

Printer: | Stylus Photo 1400 ]

Presets: | Standard ]

Print Settings J Select your

Page Setup: Standard Media Type

Media Type "Plain Paper [ Bright White Paper I
Select Color or

Grayscale

Color: | Color I

Mode: (® Automatic Quality T Speed
O Advanced Select higher

Print Quality: | Normal L quality or faster

1 High Speed printing (if available)
_é \ __ Mirror Image

@ ( PoFv ) ( Preview ) ( Supplies.. 3

+— Click Print

( Cancel )
| Sk B

Note:
For more information about printer settings, click the ? button.

Depending on your settings, you can choose other options from the pop-up
menu, including:

Copies & Pages: Select the number of copies you want or a page range.
Layout: Select page layout options.

Paper Handling: Select page printing options, such as Reverse
print order.

ColorSync or Color Management: Select ColorSync® or adjust the
color controls or gamma setting, or turn off color adjustments in the
printer software.

Expansion: Reduce or enlarge the image size for borderless printing. See
page 29 for details.

Extension Settings: Select a wider platen gap if ink smears.

Summary: View a list of all your selections.

Printing with a Macintosh
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11. Click the Advanced button and select the following settings as necessary.

Printer: _ Stylus Photo 1400 }

Presets: _Standard [

| Print Settings “3

Page Setup: Standard

Media Type: | Ultra Premium Photo Paper Glossy

f
Color: | Color |

Mode: () Automatic

Select Photo RPM

@ Advanced for the best print

: or the best prin
Pri lity: | Photo RPM [ . .
A quality on certain

4 High Speed ;
& [ Mirror Image paper types

Select various print
options here

@ ( PDF v :J ( Preview) ( Supplies... ) Cancel ) Print

Note:
When you select Photo RPM for the highest quality, printing will take longer.

12. Click Print.

13. To monitor the progress of your print job, click the §& printer icon when it
appears in the dock on the bottom of your desktop.

If you're using Mac OS X 10.2.8, click the #& Print Center icon instead, then
double-click Stylus Photo 1400 in the Printer List window.
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The following window appears and shows the progress of your print job. If
necessary, you can click the print job to select it, then use these buttons to

cancel, pause, or resume printing.

Pause printing —

Resume printing

806

Stylus Photo 1400

Cancel printing ———&) @

Delete  Hold

&

{ Active | Completed

img267.tif
Page 1 of 1

Processing job

e

Stop Jobs Utility Supply Levels

[ Status
Printing

4 Mame
img267.tif

Tip:

You can also press the @ paper button on your printer to cancel printing.

14. When you're finished, close the printer window or Print Center.

Selecting the Correct Paper Type

Select the correct paper Type or Media Type setting so your printer knows what
kind of paper you're using and adjusts the ink coverage accordingly.

For this paper

Select this paper Type
or Media Type setting

Plain paper

Epson Bright White Paper

Epson Premium Bright White Paper
Epson Iron-on Cool Peel Transfer paper
Epson Iron-On Transfer Paper

Plain Paper / Bright
White Paper

Epson Ultra Premium Photo Paper Glossy
Epson Ultra Premium Glossy Photo Paper

Ultra Premium Photo
Paper Glossy
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For this paper

Select this paper Type
or Media Type setting

Epson Premium Photo Paper Glossy
Epson Premium Glossy Photo Paper

Premium Photo Paper
Glossy

Epson Photo Paper Glossy
Epson Glossy Photo Paper

Photo Paper Glossy

Epson Presentation Paper Matte
Epson Photo Quality Ink Jet Paper
Epson Photo Quality Self Adhesive Sheets

Presentation Paper
Matte

Epson Premium Photo Paper Semi-gloss
Epson Premium Semigloss Photo Paper

Premium Photo Paper
Semi-Gloss

Epson Ultra Premium Photo Paper Luster
Epson Premium Luster Photo Paper

Ultra Premium Photo
Paper Luster

Epson Ultra Premium Presentation Paper Matte
Epson Enhanced Matte Paper

Ultra Premium
Presentation Matte

Epson Premium Presentation Paper Matte

Epson Matte Paper Heavyweight

Epson Premium Presentation Paper Matte Double-sided
Epson Double-Sided Matte Paper

Premium Presentation
Paper Matte

Envelopes

Envelope
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Printing Borderless Photos

You can print your photos with no margins, extending the image all the way to the
edges of the page. Although borderless printing is a bit slower, you get beautiful
snapshots and enlargements, without trimming. You can print borderless photos

on these papers and sizes:

Paper Glossy

Letter (8.5 x 11 inches)

Paper Type or
Paper name Sizes Media Type setting
Epson Ultra Premium Photo 4 x 6 inches Ultra Premium

Photo Paper Glossy

Epson Ultra Premium Glossy
Photo Paper

Epson Premium Photo Paper 4 x 6 inches Premium Photo
Glossy 5 % 7 inches Paper Glossy
Epson Premium Glossy Photo 8 x 10 inches

Paper Letter (8.5 x 11 inches)

11 x 14 inches

US B (11 x 17 inches)
A3 (11.7 x 16.5 inches)
Super B (13 x 19 inches)

4 x 6 inches

Letter (8.5 x 11 inches)
US B (11 x 17 inches)
Super B (13 x 19 inches)

Epson Photo Paper Glossy Photo Paper Glossy

Epson Glossy Photo Paper

Epson Presentation Paper Matte | Letter (8.5 x 11 inches)
US B (11 x 17 inches)

Super B (13 x 19 inches)

Presentation Paper

Epson Photo Quality Ink Jet Matte

Paper

Premium Photo
Paper Semi-Gloss

4 x 6 inches
Letter (8.5 x 11 inches)
Super B (13 x 19 inches)

Epson Premium Photo Paper
Semi-gloss

Epson Premium Semigloss
Photo Paper

Ultra Premium
Photo Paper Luster

Epson Ultra Premium Photo
Paper Luster

Letter (8.5 x 11 inches)
A3 (11.7 x 16.5 inches)

Epson Premium Luster Photo Super B (13 x 19 inches)

Paper

Printing Borderless Photos 23



Paper name

Sizes

Paper Type or
Media Type setting

Epson Ultra Premium
Presentation Paper Matte

Epson Enhanced Matte Paper

Letter (8.5 x 11 inches)
A3 (11.7 x 16.5 inches)
Super B (13 x 19 inches)

Ultra Premium
Presentation Matte

Epson Premium Presentation
Paper Matte

Epson Matte Paper
Heavyweight

8 x 10 inches

Letter (8.5 x 11 inches)
11 x 14 inches

A3 (11.7 x 16.5 inches)
Super B (13 x 19 inches)

Premium
Presentation Paper
Matte

See these sections for instructions on selecting printer settings:

“Borderless Printing with Windows” below

“Borderless Printing with a Macintosh” on page 27

“Storing and Displaying Your Prints” on page 29

Borderless Printing with Windows

These instructions cover printing from the Windows XP Picture and Fax Viewer,
but you can print borderless photos using these driver setting instructions from

any Windows application.

1.
2.

Right-click the photo, highlight
Open With, and select Windows
Picture and Fax Viewer.

Note:

In Windows Vista]" you can select a
photo on your system and click
Print. Then select your printer, paper
size, and type on the next screen. To
select the rest of your print options,
click Options at the bottom of the
screen and select Printer
Properties. Then continue with
step 7 to select the necessary
options.

24 Printing from Start to Finish
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3. Click the fa Print icon at the bottom of the screen.

4. Click Next. You see a Picture Selection window:

& Photo Printing Wizard

Picture Selection

Pictures with check marks will be printed. To print all pictures. click Select AlL

5. Select the photo(s) you want to print and click Next. You see the Printing

Options window:

Select EPSON Stylus
Photo 1400 Series

Click Printing
Preferences

2 Photo Printing Wizard X

Printing Options
Select the printer and paper you want ta use.

What pinter do pou want to uss?

EPSON Siylus Photo 1400 Series v [l Pk ]

“Your prints will lnok best i you select the corect paper before printing. To select paper, click
Piinting Preferences.

————————|__Piinting Preferences

Cunently selected paper:  Plain Paper ¢ Bright White Paper
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6. Select EPSON Stylus Photo 1400 Series and click Printing Preferences.
You see the printer settings window:

%" EPSON Stylus Photo 1400 Series Properties

ﬁ Main |Q2j Page Layout || & Mamlenancel

Buality Option
4 i - »
Ot OTet OTestlmage @Fhold O BestPhoto
Paper Options Frint Options
v] PhataE ph
[ Reverse Order
Type: | Ultra Premium Photo Paper Glossy | W | 1 Prirt Preview

Size: [4uEin |

Ink Levels Orientation

g g g g g g (& Portiait
b 7 b 7 b N (O Landscape
Beset Defaults Orline Support
[ 0K 1 [ Cancel ] [ Help

)

Borderless
check box

7. Select Photo or Best Photo as the Quality Option setting,.

8. Select one of the following for the paper Type option, to match the paper
you're using:

Note:

Ultra Premium Photo Paper Glossy
Premium Photo Paper Glossy
Photo Paper Glossy

Presentation Paper Matte
Premium Photo Paper Semi-Gloss
Ultra Premium Photo Paper Luster
Ultra Premium Presentation Matte

Premium Presentation Paper Matte

If you're not sure which Type to select, see the table on page 23.

9. Click the Borderless check box. Read the message and click OK.

10. Select your paper Size setting to match the paper you're using. See the list of

supported borderless sizes beginning on page 23.
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11. Select Portrait or Landscape as the Orientation setting.

Note:
If you need to adjust the amount of image expansion necessary for borderless
printing, click the Page Layout tab and adjust the Expansion slider.

12. Click OK.

Note:
In Windows Vista, follow the on-screen instructions.

13. Click Next. You see a Layout Selection window:

2 Photo Printing Wizard 3

Layout Selection
Select a layout from the chaices belon

Available lapouts: Piint preview:

Full Page Prints

Ful page fax print
centered and rotated to fit

Full page photo print |

Number af tines to use each picture 3

14. Select Full page photo print and click Next to begin printing.

Borderless Printing with a Macintosh

1. Open the photo you want to print in a printing application.

2. Open the File menu and select Page Setup. You see the Page Setup window:

Settings: | Page Attributes I :]
Format for: | Stylus Photo 1400 N Select StyIUS Photo 1400

EPSON SP 1400 Series (1)

Paper Size: | 4 x 6 in (Sheet Feeder - B... |5 }

4.00 in x 6.00 in

Orientation

Scale: 100 %

@ (Ganeel) @00

3. Select Stylus Photo 1400 from the Format for pop-up menu.
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4. Select your Paper Size setting to match the paper youre using. See the list of
supported borderless sizes beginning on page 23.

v,

Setting! A4
US Letter
Format fo US Legal
8x 10in
5x7in

EUIIESFE: « 4 x 6 in (Sheet Feeder - Borderless)
3.5x5in
16:9 wide (4 x 7.11 in)

v 4 % 6 in (Sheet Feeder - Borderless)

v YRAV ¥

5. Select [1#] portrait or [I#| landscape as the Orientation setting.
6. Click OK.

7. Open the File menu and select Print.

"

Select Stylus Photo 1400

Printer: | Stylus Photo 1400

)
Presets: | Standard )
[ Print Settings ) Select Print Settings

Page Setup: Sheet Feeder - Borderless

Media Type: " Ultra Premium Photo Paper Glossy

=
Color: _Color

Mode: @ Automatic Quality 7% Speed

() Advanced

Print Quality: = Photo

! High Speed

.di ‘\ ] Mirror Image

Print quality in the top and bottom areas may decline or the area may be smeared
"~ depending on the media.
Please refer to your manual for details.

( PDF v ) (Preview) (Supplies, ) (S(andard) ( Cancel ) M

8. Select Stylus Photo 1400 in the Printer pop-up menu.
9. Select Print Settings from the pop-up menu.

Note:
In certain programs you may need to select Advanced before you can select Print

Settings.

The automatic photo correction feature is not available with Macintosh.
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10. Select one of the following Media Types to match the paper you're using:
B Ultra Premium Photo Paper Glossy

Premium Photo Paper Glossy

Photo Paper Glossy

Presentation Paper Matte

Premium Photo Paper Semi-Gloss

Ultra Premium Photo Paper Luster

Ultra Premium Presentation Matte
B Premium Presentation Paper Matte

Note:
If you're not sure which Media Type to select, see the table on page 23.

11. Select Quality (for higher quality) or Speed (for faster printing) using the
slider, if it is available.

Note:
If you need to adjust the amount of image expansion necessary for borderless
printing, select Expansion from the pop-up menu and adjust the Expansion slider.

12. Click Print to start printing.

Storing and Displaying Your Prints

The special Epson Claria inks designed for your printer provide the ultimate
combination of photo quality and longevity when printed on Epson papers and
properly displayed or stored. For best results, always use Epson papers.

With proper care, photographs from your Epson Stylus Photo 1400 will last for
many years. As with traditional photos, Epson recommends proper care that will
minimize color changes and lengthen display life:

B Frame prints under glass or a protective plastic sleeve to protect them from
atmospheric contaminants like humidity, smoke, and high levels of ozone.

As with all photographs, keep your prints away from direct sunlight.
Keep your prints away from high temperatures.

For proper storage, keep your prints in a photo album or plastic photo storage
box in acid-free, archival sleeves commonly available from most camera stores.

B Always keep unused paper in the original package.
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Printing on CDs and DVDs

Your printer includes a special tray that lets you print customized text, graphics,
and photos directly on any ink jet-printable CD or DVD. The Epson Print CD
software makes it easy to import your own photos, add text, and modify your
designs with a variety of special effects. You can print on both regular 12-cm and

8-cm mini CDs and DVDs.

Caution:
Use only ink jet-printable CDs and DVDs for printing. Thermal-printable and regular CDs
and DVDs should not be used with this printer; otherwise the ink may smear.

Follow the steps in these sections to print on CDs or DVDs:

“Cleaning the Rollers” below

“Inserting a CD or DVD” on page 31
B “Designing and Printing a CD/DVD with Windows” on page 33
B “Designing and Printing a CD/DVD with a Macintosh” on page 37

Cleaning the Rollers

Before you print on CDs or DVDs, you need to clean the rollers inside your
printer. You can do this by feeding and ejecting several sheets of plain paper.

1. Make sure your printer is turned on and several sheets of letter-size paper
are loaded.

2. Press the @@ paper button to feed a sheet of paper through the printer.

3. Repeat step 2 several times.
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Inserting a CD or DVD

Make sure the data, music, or video is burned on your ink jet-printable CDs or
DVD:s before you print. Otherwise, dirt or scratches on the surface may cause
errors when you burn the data.

1. Turn on your printer.

Note:
Before you insert a CD or DVD, make sure the printer is turned on. Otherwise, the
disc may not be positioned correctly. Then follow these steps:

2. Remove any paper from the sheet feeder.
If the output tray is open, push it all the way in.

4. Lift up the printer cover, then press and release the front cover as shown to

open the CD/DVD tray guide.

5. Close the printer cover.
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6. Place the CD or DVD on the CD/DVD tray with the white or printable side
face-up. Make sure the disc lies flat in the tray.

To print on a small CD or DVD (8-cm), place the small CD/DVD ring on
the tray first, then place the CD or DVD inside the ring.

Caution:
Make sure you always use the small CD/DVD ring when printing on 8-cm CDs or
DVDs and that the disc and ring lie flat on the tray; otherwise the printer may be
damaged.

12-cm disc 8-cm disc

with 8-cm discs)

®

7. Slide the tray into the CD/DVD guide. Push in the tray until the arrows on
the tray and the tray guide are aligned, as shown below.

|
- L CD/DVD ring
1 Q (Always use this piece

—

8. Follow the instructions on page 33 (Windows) or page 37 (Macintosh) to
design and print with Epson Print CD.
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Designing and Printing a CD/DVD with Windows

You can use Epson Print CD to create and print a disc design with images,
graphics, and text.

Designing a CD/DVD with Windows
1. Double-click the EPSON Print CD icon on your desktop.

2. To add a background image, click the & background icon. You see a window

like this:

Background | Fie |

j No Backgiaund
Clichoard
5 s x e TWaIN
¥ :
Backgiound Dptions

Note:
If you have already chosen a background, you see a different screen. Click Select
Image.

3. Do one of the following:

B To select one of the background images provided with Epson Print CD,
click the Background tab, select the image, and click OK.

B To select one of your own images, click the File tab, click Browse to
locate your image folder, then click OK. You see thumbnail images of all
the files in the folder. Select your image and click OK.
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4. To add text, click the AEC button. Enter your text and use the tabs to apply
formatting and special effects, then click OK. (To open the window again,
double-click any block of text.)

Text Settings ]
Tert | Tet Settings | Tewt Color | Shadow | Distoion |

Text

[\acation Phatos

Vacation Photos

™ Auto Arch

Gancel Help

5. To curve a single line of text, click the text in the main window and drag the
red “handle” up or down. Then adjust it using the other handles that appear.

6. When you're finished, choose Save as from the File menu to save your file.

Note:
For additional help with Epson Print CD, open the Help menu in Epson Print CD
and select Help Topics.

Printing on a CD/DVD with Windows

After you have created your design and loaded a CD or DVD, you're ready to
print.

1. Open the File menu and select Print.

Print X
: ) Select EPSON Stylus
Frinter EFSON Stlus Photo 1400 Serles ~f R
Photo 1400 Series
Copies 1 =
Media Type: COIDVD =} Select your CD
et ‘Adjust Print Position None or DVD type
Lighter Default Darker
R
; [t Adjust Print Posit
Click None Nons SResm
£ Print Density Canfirmation Patter Tray
Posttian First Second Third e
£ Print Pastion Confirmation Patterm
coor N
cancel Help
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Make sure EPSON Stylus Photo 1400 Series is selected.
Select CD/DVD or CD/DVD Premium Surface as the Media Type setting.

2.
3.
4. Select None as the Print Confirmation Pattern setting.
5. Click Print.
Note:

When you set the copies setting to 2 or more, remove each CD or DVD from the
tray after it has been printed, and then place the next disc on the tray (see
page 31). Press the a@ paper button to resume printing.

After you print, handle the CD or DVD carefully. To allow the ink to dry, wait at
least 24 hours before playing the disc or inserting it in a drive. Keep printed discs

away from moisture and direct sunlight.

Note:

If printing on a full face (hub-printable) disc, you may need to adjust the print position to

maximize the print area.

If you need to adjust the print position or color, see the next section or page 36.

Adjusting the Print Position with Windows

If your printed images and text are not centered or positioned the way you want
on your CD or DVD, you may need to adjust the printing position. You can also
use these steps to check the position before you print on a CD or DVD.

1. Place an extra ink-jet printable CD or DVD on the CD/DVD tray and insert
it into the printer, as described on page 31.

2. Start Epson Print CD.

3. Open the File menu and select Print.

Print X
Printer [EPSON Stius Photo 1200 Series -
Copies: 1 5‘
Media Type: co/IovD -
Print Color Correction
Adjust Print Position MNone
Lighter Default Darker
302 A [ +2 43
Print Corfitrmation Pattern
Adjust Print Position
© Mone
 Print Density Confirmation Pattern Tray
Click Print Position || e | e | Man 2 £}
. . Print Position C: Pattern;
Confirmation Pattern
coor [
Print Cancel ‘ Help ‘
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4. Make sure EPSON Stylus Photo 1400 Series is selected, then click Print
Position Confirmation Pattern.

5. Click Print. The confirmation pattern is printed on the
CD or DVD.

6. Remove the CD or DVD and measure the distance from
the edge of the hole to the small cross marks labeled Top
and Right. You'll need a metric ruler with millimeters for
accurate measurements.

7. Open the File menu, select Print, |

then select Adjust Print Position. n L= 1

You see a screen like this: |
8. Click Enter Values, then input the

Top distance (from your .

measurement) in the Height (Top)

. . . P s
box. Enter the Right distance (from For Windows =
your measurement) in the Width wancia [ 2
(Right) box. ‘

9. Click OK to save the e
measurements.

Adjusting the Print Density with Windows

If ink smears on your printed CDs or DVDs, you may need to adjust the color
saturation or ink density. CDs and DVDs from different manufacturers may
absorb ink differently, so you may need to adjust the density for each type of disc.
Follow these instructions to print a color saturation check pattern, and then make
adjustments as necessary.

1. Place an extra ink-jet printable CD or DVD on the CD/DVD tray and insert
it into the printer, as described on page 31.

2. Start Epson Print CD.
Open the File menu and select Print.

4. Make sure EPSON Stylus Photo 1400 Series is selected, then click Print
Density Confirmation Pattern.

5. Click Print.
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After the pattern is printed, examine the print.

If you need to adjust the color, make the Print Color Correction setting
lighter or darker as necessary. Then repeat these steps, but select either
Second or Third as the Print Density Confirmation Pattern Position setting
to print your second or third pattern on the disc.

Note:
You can print three density patterns on one disc. Each pattern is printed in a
different location.

Remove the CD or DVD and let it dry for at least 24 hours. Then check the
saturation levels again.

Note:

You can also use the Brightness and Contrast settings in Epson Print CD to adjust

color saturation. For additional information, open the Help menu in Epson Print CD
and select Help Topics.

Designing and Printing a CD/DVD with a
Macintosh

You can use Epson Print CD to create and print a disc design with images,
graphics, and text.

Designing a CD/DVD with a Macintosh

1.

Open the Applications folder, open the EPSON Print CD folder, then select
EPSON Print CD.

Adjust Background

To add a background image, click the @
background icon. You see the following
window:

To select a background image, click Select
Background, locate the folder your
images are stored in, select the one you
want, then click Open.

Click OK in the Adjust Background

= (None 8
1 None s
window. 2 e P
' E ‘Quter Edge Blur None I:!
Spot Color Effect Mosaic _Mone e !
e S Gamma Correction | 1 A
() sepia = =
= Retation Angle(") [0 S
e g
Select Background TWAIN &)

( Delete Background ) ( Cancel ) ( oK )
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5. To add text, click the T button. In the Text Settings window, type your text,
then use any of the options in the window to format it. You can also use
options in the Color Settings and Object Settings windows.

(6] Text Settings

Vacation Phatos

syle

[ Bald

O alic

) underline
Layout

@ align Left
O center

(O Align Right

() Add shadow

6. To curve a single line of text, click the text in the main window and drag the
red “handle” up or down. Then adjust it using the other handles that appear.

7. When you're finished, choose Save as from the File menu to save your file.

Note:
For additional help with Epson Print CD, open the Help menu in Epson Print CD
and select EPSON Print CD Help.

Printing on a CD/DVD with a Macintosh

After you have created your design and loaded a CD or DVD, you're ready to
print.

1. Open the File menu and select Print.

2. Click the Select Printer button and select Stylus Photo 1400 from the
printer list, then click OK.

3. Select CD/DVD or CD/DVD Premium Surface as the Media Type setting.

4. Select None as the Test Print Pattern setting.

38 Printing from Start to Finish



5. Click Print.

Click here and select
Stylus Photo 1400

Select your CD or
DVD type

Print

EPSON

Printer:

Copies:

( Sselect Printer )

Stylus Phota 1400

1

[ Manual Print |
—

Media Type: [ CD/DVD B

[ Color Carrection

B Test Print Pattern
Light Standard Strong

@ None

O Print Density Check Pattern

Click None

0 +1 +2 +3
—Adjust Print Position

Horizontal 0.0 mm
Vertical 0.0 mm

Pesition

First Time Second Time Third Time

O Print Position Check Pattern

—Try—)

=

( Position Adjustment )

Note:

When you set the copies setting to 2 or more, remove each CD or DVD from the

tray after it has been printed, and then place the next disc on the tray (see

page 31). Press the a@ paper button to resume printing.
After you print, handle the CD or DVD carefully. To allow the ink to dry, wait at
least 24 hours before playing the disc or inserting it in a drive. Keep printed discs
away from moisture and direct sunlight.

Note:
If printing on a full face (hub-printable) disc, you may need to adjust the print position to
maximize the print area.

If you need to adjust the print position or color, see the next section or page 41.

Adjusting the Print Position with a Macintosh

If your printed images and text are not centered or positioned the way you want,
you may need to adjust the printing position. You can also use these steps to check
the position before you print on a CD or DVD.

1. Place an extra ink jet-printable CD or DVD on the CD/DVD tray and insert
it into the printer, as described on page 31.

2. Start Epson Print CD.
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3. Open the File menu and select Print.

Print

EPSON
Printer:  Stylus Photo 1400
Copies: |1
Media Type: | CD/DVD —
—Color Correction ————— [ Test Print Pattern
Light Standard strong | | O None

T ) o0
0 0O O SE S S

S e e First Ti Second T Third T
osition irst Time econ ime L\ hird Time ) H H HH
— Adjust Print Position Click Print Position

O O Print Density Check Pattern

Horizontal 0.0 e @® Print Position Check Pattern
Vertical 0.0 - Check Pattern
Position Adjustment

Comr )

4. Make sure Stylus Photo 1400 is selected, then click Print Position Check
Pattern.

5. Click Print. The confirmation pattern is printed on the
CD or DVD.

6. Remove the CD or DVD and measure the distance from
the edge of the hole to the small cross marks labeled Top
and Right. You'll need a metric ruler with millimeters for
accurate measurements.

7. Open the File menu, select Adjust Prin Position
Print, then select Position -
Adjustment. You see a screen
like this:

8. Click Value Entry, then input 0

the Top distance (from your
measurement) in the Top Space
box. Enter the Right distance
(from your measurement) in the

™ Value Entry
Top Space
A
250 &) mm

Right Space

e

Right Space box. IE 7010
. Reset
9. C(lick OK to save the 0.0 mm
measurements.

40 Printing from Start to Finish



Adjusting the Print Density with a Macintosh

If ink smears on your printed CDs or DVDs, you may need to adjust the color
saturation or ink density. CDs and DVDs from different manufacturers may
absorb ink differently, so you may need to adjust the density for each type of disc.
Follow these instructions to print a color saturation check pattern, and then make
adjustments as necessary.

Place an extra ink jet-printable CD or DVD on the CD/DVD tray and insert

1.

it into the printer, as described on page 31.
Start Epson Print CD.

Open the File menu and select Print.

Make sure Stylus Photo 1400 is selected, then click Print Density Check

Pattern.
Click Print.

After the pattern is printed, examine the print.

If you need to adjust the color, make the Color Correction setting lighter or
darker as necessary. Then repeat these steps, but select either Second Time or
Third Time as the Print Density Check Pattern Position setting to print your

second or third pattern on the disc.

Note:

You can print three density patterns on one disc. Each pattern is printed in a

different location.

Remove the CD or DVD and let it dry for at least 24 hours. Then check the

saturation levels again.

Note:

You can also use the Brightness and Contrast settings in Epson Print CD to adjust
color saturation. For additional information, open the Help menu in Epson Print CD

and select EPSON Print CD Help.
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Direct Printing from a Digital Camera or
Camera Phone

You can connect a digital camera or camera phone that supports PictBridge or
USB DIRECT-PRINT printing to the Epson Stylus Photo 1400 and use the
camera or phone to control printing of your photos. (A cable may not be included
with your camera or phone.)

Check your camera or phone manual to see if it supports PictBridge or USB
DIRECT-PRINT. If it doesn’t, the red O ink and @@ paper lights flash alternately
when you connect your camera or phone. Epson cannot guarantee the
compatibility of any cameras or phones.

The file format of your images must be JPEG, and the size of each image must be
at least 80 x 80 pixels but not more than 9200 x 9200 pixels.

1. Make sure your Epson Stylus Photo 1400 is turned on, but not printing.
2. Load the type of paper you want to use. See page 7.
3. Connect the USB cable that came

with your camera or phone to the
A4 PictBridge port on the front of the
printer.

4. Connect the other end of the cable to
your camera or phone.

5. Turn on your camera or phone.

6. Use your camera or phone to select
the photos you want to print, adjust
any necessary settings, and print your
photos. See your camera or phone
manual for details.
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Maintaining Your Printer

Follow the steps in these sections to keep your Epson Stylus Photo 1400 in great
shape and transport it, if necessary.

“Checking the Print Head Nozzles” below
“Cleaning the Print Head” on page 44

“Aligning the Print Head” on page 53

|
|
B “Replacing an Ink Cartridge” on page 46
|
B “Cleaning the Printer” on page 54

|

“Transporting the Printer” on page 55

Checking the Print Head Nozzles

You can run a nozzle check to see if the print head needs cleaning. Follow the
instructions below.

Before you check the print head nozzles, make sure the CD/DVD tray is not
inserted in the printer.

1. Make sure the printer is turned on but not printing, and the red 0 ink light is
not on. (If the red O ink light is on, you need to replace a cartridge; see

page 46 for details.)
2. Make sure letter-size plain paper is loaded in the printer.

3. Windows: Right-click the #3 printer icon on your taskbar (in the lower right
corner of your screen). Select Nozzle Check.

Macintosh: Open the Applications folder and select EPSON Printer
Utility2. Select SP 1400 Series in the printer list, click OK, and select
Nozzle Check.
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4. Follow the instructions on the screen to print the nozzle check pattern.

Print head does
not need to be
cleaned:

Print head needs
to be cleaned:

5. If there are no gaps or lines, click Finish.

If there are gaps or lines, or the test patterns are faint, click Clean and follow
the on-screen instructions to clean the print head.

Cleaning the Print Head

If your printouts are unexpectedly light or dots or lines are missing, you may need
to clean the print head. This unclogs the nozzles so they can deliver ink properly.
Print head cleaning uses ink, so clean it only if quality declines.

Note:

Before you clean the print head, check the print head nozzles first to confirm that the
print head needs to be cleaned. This saves ink. For more information, see page 43.

This section explains how to clean the print head using the Head Cleaning Utility.
You can also clean the print head by holding down the 0 ink button on the printer
for three seconds. (This only works when the red 0 ink light is off.)

Before you clean the print head, make sure the CD/DVD tray is not inserted in
the printer.

Caution:
When you don’t turn on your printer for a long time, print quality can decline, so turn it
on and print a few pages at least once a month to maintain the best print quality.
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Make sure the printer is turned on but not printing, and the red 0 ink light is
off. (If the red O ink light is flashing or on, you need to replace a cartridge; see
page 46 for details.)

Do one of the following:

B Windows: Right-click the # printer icon on your taskbar (in the lower
right corner of your screen). Select Head Cleaning.

B Macintosh: Open the Applications folder and select EPSON Printer
Utility2. Select SP 1400 Series in the printer list, click OK, then select
Head Cleaning.

Follow the instructions on the screen to clean the print head.

The printer cleans the print head and the green O power light flashes.
Cleaning takes about two minutes.

Caution:
Never turn off the printer while head cleaning is in progress. You may damage it.

When the green O power light stops flashing, make sure paper is loaded in the
printer, click Print Nozzle Check Pattern, then click Print.

The nozzle check pattern prints.
Print head does

not need to be
cleaned:

Print head needs
to be cleaned:

If there are no gaps or lines, click Finish.

If there are gaps or lines, or the test patterns are faint, click Clean and follow
the on-screen instructions to clean the print head again.

If you don't see any improvement after cleaning four times, turn the printer
off and wait at least 6 hours. This allows any dried ink to soften. Then, try
cleaning the print head again.

If you still don’t see any improvement, refer to “Problems and Solutions” on

page 60.

Cleaning the Print Head
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Replacing an Ink Cartridge

When the red O ink light flashes, one or more ink cartridges are low on ink.

When the red O ink light stays on, you need to replace one or more cartridges.

Ink button and light

You'll also see a message on your screen when you print telling you which cartridge

is low or expended.

When a cartridge is more than six months old, you may need to replace it if
printouts don’t look their best. If the quality doesn’t improve after cleaning and
aligning the print head, you can replace the cartridge even if the red O ink light is

off.

Checking the Ink Status

To check the ink status, do one of the following:

B  Windows: Double-click

the # printer icon on
your taskbar (in the
lower right corner of
your screen). You see a
window like this one:

Note:

To see the part numbers
for the ink cartridges
currently installed in your

printer, click Information.
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B Macintosh: Open the Applications folder and select EPSON Printer
Utility2. Select SP 1400 Series in the printer list, click OK, then select
EPSON StatusMonitor.

You see a window like this one:

e 0 0
EPSON k SP 1400 Series (EPSON USB)

EPSON StatusMonitor

EPSON StatusMonitor

Remaining Ink level

JR0——

Click the image of the ink cartridge to display
information about the current cartridge.

Click a cartridge image to
display information about it.

=)

Purchasing Ink Cartridges

Use these Epson ink cartridges within six months of installing them and before the
expiration date on the package:

Ink cartridge Part Number
Black 79 (T079120)
Cyan 79 (T079220)
Magenta 79 (T079320)
Yellow 79 (T079420)
Light Cyan 79 (T079520)
Light Magenta 79 (T079620)

Caution:

To ensure the best results, use genuine Epson ink cartridges and do not refill them.
Other products may cause damage to your printer not covered by Epson’s warranty.
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You can purchase genuine Epson ink and paper from an authorized Epson reseller.
To find the nearest reseller, please call 800-GO-EPSON (800-463-7766). Or you
can purchase online at http://www.epsonstore.com (U.S. sales) or
http://www.epson.ca (Canadian sales).

Ink Cartridge Precautions

Warning:
Keep ink cartridges out of the reach of children and do not drink the ink.

Be careful when you handle used ink cartridges; there may be ink remaining around the
ink supply port. If ink gets on your skin, wash it off with soap and water. If it gets in your
eyes, flush them immediately with water.

Caution:
After bringing an ink cartridge inside from a cold storage site, allow it to warm up at
room temperature for at least three hours before using it.

Do not use an ink cartridge beyond the date printed on the package. For best results,
use up the ink cartridges within six months of first installing them.

Do not shake ink cartridges after opening their packages; this can cause leakage.

Do not remove or tear any label or seal on the cartridge other than the yellow tab; this
can cause leakage.

Do not touch the green IC chip on the side of the cartridge. Doing so may prevent
normal operation and printing.

Install an ink cartridge immediately after you remove it from its package. Leaving the
cartridge unpacked for a long time before using it can result in reduced print quality.

If you remove an ink cartridge for later use, protect the ink supply area from dirt and

dust, and store it in the same environment as the printer. A valve in the ink supply port
makes covers or plugs unnecessary, but the ink may stain items that come into contact
with this area of the cartridge. Do not touch the ink supply port or the surrounding area.

Do not dismantle ink cartridges or try to refill them. This could damage the print head.

Store ink cartridges with their labels facing upward. Do not store cartridges upside
down.

Store ink cartridges in a cool, dark place.
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Note:
You cannot continue printing with one ink cartridge expended, even if the other
cartridges still contain ink. Before printing, replace the expended cartridge.

The IC chip on these ink cartridges retains a variety of cartridge related-information,
such as the ink cartridge status, so that the cartridge may be removed and reinserted
freely. However, each time the cartridge is inserted, some ink is consumed because the
printer automatically performs a reliability check.

If you remove a cartridge that is low (for which you have received an “Ink low"
message), you cannot reuse it.

Removing and Installing Ink Cartridges
Be sure you have a new ink cartridge before you begin. Once you start replacing a
cartridge, you must complete all the steps in one session.

Caution:
Leave the expended cartridge installed until you have obtained a replacement, or the
ink remaining in the print head nozzles may dry out.

To ensure good results, use genuine Epson ink cartridges and do not refill them. Other
products may cause damage to your printer not covered by Epson’s warranty.

Do not open ink cartridge packages until you are ready to install the ink. Cartridges are
vacuum packed to maintain reliability.

1. Make sure the CD/DVD tray is not inserted in the printer.

2. Make sure the printer is turned on, but the green © power light is not
flashing.

3. Open the printer cover.

4. Press the 0 ink button. The O power light begins to flash.

Caution:
Don’t hold down the 0 ink button for more than 3 seconds or the printer will start to
clean the print head.

Replacing an Ink Cartridge
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If one of the cartridges is low or expended, the print head moves that cartridge
to the & mark. Go to step 5.

If no cartridges are low or expended, the cartridge holder moves directly to the
ink cartridge replacement position. Go to step 6.

Caution:
To avoid damaging the printer, never move the print head by hand.

Do not touch the area shown below when you are changing ink cartridges.

5. Press the O ink button again.

If more than one cartridge is low or expended, the next low or expended
cartridge moves to the & mark. Press the O ink button to continue checking

the cartridges.

After the printer identifies all the low or expended ink cartridges, the print
head moves to the ink cartridge replacement position.
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6. Open the cartridge cover.

7. Squeeze the tab at the back of the cartridge and lift it straight out. Dispose of
it carefully. Don'’t take the used cartridge apart or try to refill it.

Warning:
If ink gets on your hands, wash them thoroughly with soap and water. If ink gets in
your eyes, flush them immediately with water.

8. Remove the new cartridge from its package.

Caution:

Do not touch the green IC chip on the side of the cartridge. Doing so may prevent
normal operation and printing.
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9. Remove the yellow tape from the bottom of the ink cartridge.

Caution:
You must remove the yellow tape from the cartridge before you install it;
otherwise, print quality may decline or you may not be able to print.

Don’t remove any other seals from the cartridge; this can cause leakage.

10. Place the new ink cartridge into the cartridge holder and push it down until it
clicks into place.

11. Replace any other cartridges that need to be replaced.
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12. Close the cartridge cover.

13. Close the printer cover and press the O ink button. The printer begins
charging ink.

The green O power light flashes and the printer makes noise. Charging takes
about two minutes. When it’s finished, the green O] power light stops flashing
and stays on, and the red O ink light goes out.

Caution:
Never turn off the printer while the green O power light is flashing, or you'll waste
ink.

Note:

If the red 0 ink light stays on, an ink cartridge may not be installed correctly. Open
the printer cover and press the 0 ink button two or more times. Then open the
cartridge cover and press down all the cartridges until they click into place. Close
the cartridge and printer covers, and press the 0 ink button to charge the ink.

Aligning the Print Head

If your printouts look grainy or blurry, or you see light or dark lines, you may need
to align the print head.

Note:
You may also see lines in your printouts if your cartridges are low on ink or you need to
clean the print head.

Before you align the print head, make sure the CD/DVD tray is not inserted in
the printer.

1. Turn on the printer.

2. Load several sheets of plain, letter-size paper.
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3. Make sure the @@ paper and O ink lights are not flashing or on.
4. Do one of the following:

B  Windows: Right-click the @& printer icon on your taskbar (in the lower
right corner of your screen). Select Print Head Alignment.

B Macintosh: Open the Applications folder and select EPSON Printer
Utility2. Select SP 1400 Series in the printer list, click OK, then select
Print Head Alignment.

5. Follow the instructions on the screen to @

print the alignment pattern. You see a oy, Ul
Find the square without any visible bands in sets #1 thiough #3. Select
WindOW hke thiS one: #w:er;\ugﬁk;Elrt‘}:‘.iasthcurrespnnds to that square from the list below: for all sets.
IF every square contains a band, select the square with the thinnest band
Note: of bands. Then click Realignment.

Do not cancel printing while the alignment
sheet is printing.

6. Look at the three sets of patterns in your
printout. For each set, if you see a
pattern with no streaks or lines, enter its
number in the corresponding box on the
screen.

[ Finish | [ Aediowment | | Cancel

If every pattern in a set contains lines or streaks, select the pattern that looks
the best. Click Realignment, then click Print to print another alignment
sheet and repeat this step.

7. Click Finish to exit the Print Head Alignment utility.

Cleaning the Printer

To keep your printer working at its best, you should clean it several times a year.
1. Turn off the printer, unplug the power cord, and disconnect the USB cable.
2. Remove all the paper, then use a soft brush to clean the sheet feeder.

3. If the outer case or inside of the sheet feeder are dirty, clean them with a soft
cloth dampened with mild detergent. Keep the printer cover closed to prevent
water from getting inside.
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4. 1If ink accidentally gets inside
the printer, wipe it off with a

damp cloth in the area shown. _
Clean plastic
Warning: area here
Don’t touch the gears or any

other parts inside the printer.

Caution:

Never use a hard or abrasive :
brush, or benzine, alcohol, or paint thinner for cleaning; they can damage the
printer components and case.

Don’t get water on the printer components and don't spray or apply lubricants, oils
or grease inside the printer.

Don’t use any cleaning sheets included with special paper; they may jam inside the
printer.

Transporting the Printer

If you need to ship your printer, you must prepare it for transportation by packing
the printer in its original box or one of a similar size.

Caution:
Leave the ink cartridges installed. Removing the cartridges can dry out the print head
and may prevent the printer from printing.

1. Turn off the printer.

2. Remove any paper from the sheet feeder and close the paper support.
3. DPush in the output tray extensions and close the tray.
4

Unplug the power cord from the electrical outlet. Then disconnect the USB
cable from the printer.

5. Repack the printer in the original box using the protective materials that came
with it.

Caution:
During transport, do not tilt the printer, stand it up vertically, or turn it upside down, or
ink may leak from the cartridges.

After transporting the printer, plug it in and turn it on. If you notice a decline in
print quality, clean the print head (see page 44); if output is grainy or blurry, align
the print head (see page 53).
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Solving Problems

If your Epson Stylus Photo 1400 has any problems, see these sections for
solutions:

B “Diagnosing Printer Problems” below
B “Problems and Solutions” on page 60

If you need to uninstall and reinstall your software to solve a problem, see
“Uninstalling Printer Software” on page 70.

If the solutions here don't solve your problem, see “Where To Get Help” on
page 71.

Diagnosing Printer Problems

a@ paper light
0 ink light

O power light

First, check the printer’s lights (see below) or run a printer check (see page 59).

Lights Explanation
Green O power light The printer is receiving a print job, replacing an ink
flashes cartridge, charging ink, or cleaning the print head, or a

camera is connected to the A PictBridge port.

Red a@ paper light is If you're printing on paper, your paper ran out or multiple
onand green O power | pages have fed at once. Load or reload your paper, then
light flashes press the @@ paper button to resume printing.

If you're printing on a CD or DVD, the CD/DVD tray is not
inserted. Follow the instructions beginning on page 31 to
insert the tray, then press the & paper button.
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Lights

Explanation

Red a@ paper light
flashes and green O
power light flashes

If you're printing on paper, it is jammed in the printer.
Press the @@ paper button to eject the paper. If that
doesn’t work, turn off the printer, open the cover, and pull
the paper out from the front, including any torn pieces.
Then turn on the printer, reload paper, and press the

@@ paper button.

If you're printing on a CD or DVD, the CD/DVD tray has
not ejected. Pull out the tray and press the &@ paper
button.

Red 0 ink light flashes

An ink cartridge is nearly expended. Check the message

that appears on your screen to determine which cartridge
is nearly expended or follow the instructions on page 46.

Make sure you have a replacement cartridge.

Red 0 ink light and
green O power light
are on

An ink cartridge is expended or not installed. Make sure
you have a replacement cartridge, then follow the steps
on page 46 to install it.

If you have just installed a new cartridge, it may be
incompatible with the printer or incorrectly installed.
Reinstall it or replace it with the correct cartridge, as
described on page 46.

Red a1 paper and red
0 ink lights flash rapidly

Paper is loaded for printing, but the CD/DVD tray guide is
open. If you want to print on paper, close the CD/DVD tray
guide. If you want to print on a CD or DVD, remove the
paper from the sheet feeder.

Green O power light is
on; red & paper and
red 0 ink lights flash
alternately

An unsupported device is connected to the A PictBridge
port. Only devices compatible with PictBridge or USB
DIRECT-PRINT can be connected to this port. See

page 42 for more information.

The O power light is
off; red &@ paper and
red 0 ink lights flash

Paper may be blocking movement of the print head or the
printer may have an internal error. Turn off the printer,
then open the cover and remove any jammed paper or
other foreign objects. Wait a few seconds, then turn the
printer back on again. If the lights are still flashing, contact
Epson as described on page 71.
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Running a Printer Check

You can run a printer check to determine whether a problem comes from the
printer or some other source.

Before you run a printer check, make sure the CD/DVD tray is not inserted in the

printer.

1.

Turn off both the printer and computer. Then disconnect the USB cable from
the printer.

Make sure letter-size plain paper is loaded in the printer.

Press the &% paper and O power buttons together to turn on the printer.
Continue holding down the 6% paper button until the green Q) power light
starts to flash, then release it.

@@ paper button

O power button

A test page prints showing the printer’s ROM version number and a nozzle
check pattern. (If the pattern has gaps, you need to clean the print head as
described on page 44.)

Turn off the printer after it prints the test page. Then reconnect the USB cable
and turn on your printer and computer.

If the test page prints, the problem probably lies in your software settings,
the USB cable, or your computer, or your software may not be installed
correctly. To uninstall and reinstall the software, see page 70.

If the test page doesn’t print, you may have a problem with your printer.
Try the suggestions in “Problems and Solutions” on page 60. If nothing
works, contact Epson as described in “Where To Get Help” on page 71.
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Problems and Solutions

Tip:
If you don't find the information you're looking for in this section, please check the
on-screen Reference Guide.

Setup and Software Installation Problems

Tip:

Periodically, it's a good idea to check Epson’s support website at epson.com/support
for free updates to your Epson Stylus Photo 1400 printer software. Download
instructions are posted for your convenience. With Windows, you can also click Start or
@©. select Programs or All Programs, select EPSON, and click

EPSON Stylus Photo 1400 Series Driver Update for printer driver updates.

The printer makes noise after ink cartridge installation.

B The first time you install ink cartridges, the printer must charge its print head
for three minutes or so. Wait until charging finishes (the green O power light
stops flashing) before you turn off the printer, or it may charge improperly
and use excess ink the next time you turn it on.

If the print head stops moving or the printer stops making noise, but the
green Q) power light is still flashing after 5 minutes, turn off the printer. If the
light is still flashing when you turn it back on, contact Epson as described in

“Where To Get Help” on page 71.

B Turn off the printer, then make sure the ink cartridges are inserted completely
and the ink cartridge cover is closed completely. Also make sure no packing
material remains in the printer. Wait a moment, then turn the printer back on
to clear the error.

You’re having problems installing the printer software.

B Carefully follow the installation instructions on the Szart Here sheet. Do not
connect your printer to the computer until you are instructed to do so and
make sure the cable is securely connected. Also make sure your system meets
the requirements shown on page 73.

B Close your other programs, including any screen savers and virus protection
software, and install the software again.
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B If you are using a Macintosh and you do not see the printer name in the
Format for menu on the Page Setup screen, you may need to set up your
printer in the Printer Setup Utility or Print Center. See the Szarr Here sheet for
instructions.

B If you're using Windows 2000 and you see an error message or your software
doesn’t install correctly, you may not have software installation privileges.
Contact your System Administrator.

B Make sure Windows 2000 or XP was preinstalled on your system. The USB
Printer Device Driver may not install correctly if you've upgraded from

Windows 95.

B Make sure the USB Controller is working properly in Device Manager. See
your Windows help system for details. If it’s not working, contact your
computer manufacturer.

B Ifyou're printing on a network, see your on-screen Reference Guide for
instructions on configuring your printer for use on a network.

Printer Problems

The printer is on, but nothing prints.

B Make sure the USB cable is connected securely and that the cable meets the
system requirements on page 73.

B Run a printer check as described on page 59. If the test page prints, make sure
your software is installed correctly. You may need to uninstall and reinstall it as

described on page 70.
Make sure there is no packing material in the printer.

If you're printing on a network, you need to set up your printer for network
printing, as described in your on-screen Reference Guide.

B If you print continuously for an extended period, the paper may temporarily
stop feeding or the print head carriage may pause for a while to prevent the
printer mechanism from overheating and being damaged. If this happens, you
can continue to print but Epson recommends that you stop and leave the
printer on for about 30 minutes. After 30 minutes, turn the printer off and on
and it should print at normal speed.

Problems and Solutions
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The printer sounds as though it is printing, but nothing prints.

B Ifyou're using Windows, make sure your printer is selected. If you're using a
Macintosh, make sure your printer is selected in the Page Setup and Print
windows.

The print head nozzles may need cleaning; see page 44 for instructions.

Make sure the printer software settings are appropriate for the paper size
you're using.

B The printer won't operate properly if it’s tilted or at an angle. Place it on a flat,
stable surface that extends beyond the printer base in all directions.

Your printer makes noise when you turn it on or after it has been sitting for
awhile.

Your printer is performing routine maintenance.

Printing is too slow.

Make sure your system meets the requirements listed on page 73. If you're
printing a high-resolution image, you need more than the minimum requirements
listed. You may also need to:

B Clear space on your hard drive or run a defragmentation utility.
B Close open programs that you're not using.

B Increase your system’s memory (RAM).

For the fastest printing, try these tips:

B Set the Quality Option to Draft (Windows) or the Quality/Speed slider to
Speed (Macintosh).

B Ifyour printer is connected to a USB hub, disconnect USB devices that you're
not using,.

Note:
Borderless printing takes longer, especially near the edges of the paper.
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Print Quality Problems

You see banding (light lines).

Your printout is blurry or smeared.

The print head nozzles may need cleaning;
see page 44 for instructions.

Select a higher print quality and turn off 3 ]
High Speed mode; see page 15 (Windows) TN TTT——
or page 19 (Macintosh) for instructions. =

N
=
B—- %

Make sure the Type or Media Type setting matches the paper you loaded; see
page 21 for guidelines.

Make sure the printable side of the paper is face-up. It’s usually brighter or
whiter.

The ink cartridges may need replacing; see page 46 for instructions.

Make sure you're using genuine Epson ink cartridges and you use them
within six months after you open the packages.

If you have a Macintosh, try using Automatic mode; see page 18 for
instructions.

Align the print head; see page 53 for instructions.

Make sure your paper isn’t damp or curled,
or loaded face down (the printable side
should be face up).

Make sure your paper is not damaged, dirty,
or too old.

Make sure the Type or Media Type setting
matches the paper you loaded; see page 21 for guidelines.

Use a support sheet with special paper or load your paper one sheet at a time.

Make sure your paper meets the specifications listed in the on-screen Reference

Guide.

Use Epson papers to ensure proper saturation and absorption of genuine
Epson inks.
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B Make sure you're using genuine Epson ink cartridges and you use them within
six months after you open the packages.

B The printer won't operate properly if it’s tilted or at an angle. Place it on a flat,
stable surface that extends beyond the printer base in all directions.

The print head nozzles may need cleaning; see page 44 for instructions.
Align the print head; see page 53 for instructions.
Remove each sheet from the output tray as it is printed.

Avoid handling printouts for a few hours to allow the ink to set.

If ink smears on the back of a printout, clean the inside of the printer; see
page 54 for instructions.

Your printout is faint or has gaps.

B The print head nozzles may need cleaning;
see page 44 for instructions.

B The ink cartridges may be old or low on ink.
To replace an ink cartridge, see page 46.

B Make sure the Type or Media Type setting
matches the paper you loaded; see page 21
for guidelines.

B Make sure your paper isn't damaged, old, dirty, or loaded face-down. For best
results, use genuine Epson paper.

Caution:

Don't open Epson Status Monitor, pause printing, or respond to any ink messages
when your printer is printing. This may cause your printer to pause and leave an uneven
surface on your printout. If your ink is running low, wait until printing finishes before
checking ink levels or attempting to replace a cartridge. If you must replace an ink
cartridge in the middle of a print job, the quality of your printout may decline. For best
results, check your ink levels and replace ink cartridges, if necessary, before printing
large or high-resolution print jobs.
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Your printout is grainy.

Make sure the printable side of the paper is face-up. It’s usually brighter or
whiter.

Try using a higher quality paper or select a higher Quality Option or Print
Quality setting; see page 15 (Windows) or page 19 (Macintosh) for

instructions.
Run the Print Head Alignment utility; see page 53 for instructions.

ou may need to increase the image resolution or print it in a smaller size; see
You may need to in th lution or print it ller si
your software documentation.

You see wrong or missing colors.

Clear the Grayscale setting in your printer software (Windows) or change
the ink setting in your printer software to Color (Macintosh).

The print head nozzles may need cleaning; see page 44 for instructions.
The ink cartridges may be old or low on ink; see page 46.
If youre using Windows, try turning off PhotoEnhance.

Try changing the Gamma setting; see your on-screen Reference Guide for
more information.

After you print, the colors on your printout will take some time to set as the
ink dries. During this time, the colors may look different than you expect. To
reduce the drying time, avoid stacking your prints on top of each other.

Your printed colors can never exactly match your on-screen colors. However,
you can use a color management system to get as close as possible. You can
also use your printer’s color management features. See your on-screen
Reference Guide for more information.

Problems with Paper Feeding

Paper doesn’t eject fully or is wrinkled.

If the paper doesn’t eject fully, you may have set the wrong paper size. Press the
@4 paper button to eject the paper, then select the correct paper size.

If it’s wrinkled when it ejects, the paper may be damp or too thin. Make sure
your paper meets the specifications listed in the on-screen Reference Guide.
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Paper doesn’t feed correctly or jams in the printer.
B Make sure the paper support extension is pulled up.

B If paper doesn’t feed, remove it from the sheet feeder, reload it against the right
edge, then slide the left edge guide against the paper.

B If multiple pages feed at once, remove the paper from the sheet feeder, fan the
edges to separate the sheets, and carefully reload it.

W If paper jams, press the 8% paper button to clear the jam. If that doesn’t work,
turn off the printer, open the cover, and pull the paper out from the front,
including any torn pieces. Then turn on the printer, reload paper, and press
the @@ paper button.

If your paper loads incorrectly or jams frequently:

B Use new, smooth, high-quality paper, loaded printable side up. Make sure the

paper is not curled, creased, wrinkled, too thin, or too old.
Fan the edges of the stack of paper to separate the sheets.
Don’t load paper above the arrow mark on the left edge guide.

Place the paper against the right edge behind the tab. Slide the left edge guide
against it, but not too tightly.

B Store paper flat to prevent curling.

Paper dust may have built up on the paper rollers. Use Epson Ink Jet Printer
Cleaning Sheets (part number S041150) to clean the rollers as follows:

Caution:
Do not use the cleaning sheets that come with Epson special papers; they may
jam inside your printer.

1. Remove any paper loaded in the printer’s sheet feeder.
2. Remove the instruction sheet from the sticky side of the cleaning sheet.

Caution:
Do not follow the loading instructions on the sheet; they are not correct for your
printer. Follow the steps here instead.

66 Solving Problems



3. Dosition the cleaning sheet in the printer’s sheet feeder with the cut corner
in the lower left. Make sure the sticky side of the cleaning sheet is face up.

Sticky side of cleaning sheet

Cut corner

4. Press the @@ paper button to feed the sheet through the printer.

5. When the sheet ejects, repeat steps 3 and 4 to feed the sheet through two
more times. Then discard the cleaning sheet.

CD/DVD Printing Problems

Images and text are not centered on the CD/DVD.

Adjust the print position as described on page 35 (Windows) or page 39
(Macintosh).

Ink smears on the CD/DVD or printing is too light.
B Make sure you're using ink jet-printable CDs or DVDs.

B Handle the disc carefully and allow the ink to dry for at least 24 hours before
playing the disc or inserting it in a drive.

B Adjust the print density as described on page 36 (Windows) or page 41
(Macintosh).

B Adjust the brightness or contrast. See the Epson Print CD on-screen help.
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Printed CDs or DVDs are dirty.
Clean the rollers as described on page 30.

The CD/DVD won'’t feed into the printer.

Turn on your printer and gently insert the CD/DVD tray along the tray guide
until the arrows on the CD/DVD tray and tray guide match each other. For more
information, see page 31.

The CD/DVD tray is ejected or not fed correctly when a print job is sent.
B Reinsert the CD/DVD tray correctly; see page 31 for instructions.

B If the tray is ejected when you start a print job, the printer is not ready. Wait
until you see a message on your screen asking you to insert the tray. Then
reinsert the tray and press the 8% paper button.

Miscellaneous Printout Problems

The image is inverted, as if viewed in a mirror.

Turn off the Mirror Image setting in the printer software or your application
program. (If you're printing on Epson Iron-on Cool Peel Transfer paper, the image

should be inverted.)

The printer prints blank pages.

B If you're using Windows, make sure your printer is selected. If you're using a
Macintosh, make sure your printer is selected in the Page Setup and Print
windows.

B The print head nozzles may need cleaning; see page 44 for instructions.

The margins are incorrect.

B Make sure the paper settings are correct for your paper size. For instructions,

see page 14 (Windows) or page 18 (Macintosh).
Choose the correct margins for your paper size.

If youre using a Macintosh, make sure you choose the same printer in the
Page Setup window and the Print window.
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B Use the Print Preview option in your printer software to check your margins
before you print.

B Make sure the paper is positioned all the way to the right of the sheet feeder.
Slide the left edge guide against the paper.

The image size or position is incorrect.

B Make sure the paper and layout options are set correctly. See page 14
(Windows) or page 18 (Macintosh) for instructions.

B Your images may not match the width/height proportions of the paper size or
layout you're using, and may be cropped to fit.

You see incorrect characters.

B Make sure the USB cable is securely connected and meets the system
requirements on page 73. Then try printing again.

B Ifyoure using a switch box or USB hub with your printer, connect the printer
directly to your computer instead.

Too many copies are printing.

Make sure that the Copies option in your printer software or program is not set for

multiple copies.

Output is not what you expect when printing borderless photos.

B Make sure you are printing on paper that supports borderless printing. See the
list of supported borderless paper types and sizes on page 23.

B Use the expansion setting to adjust how the image fits on the page. See
“Printing Borderless Photos” on page 23.

B Don’t choose a custom paper size setting when printing borderless photos.
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Uninstalling Printer Software

You may need to uninstall and then reinstall your printer driver and utilities. For
example, this might be necessary when you upgrade your operating system. You
don’t need to uninstall Epson Print CD or your on-screen Reference Guide.

Windows
1. Turn off the printer and disconnect its USB cable.
2. Click Start or €, and select Programs or All Programs.

3. DPoint to Epson or Epson Printers, then select Epson Printer Software
Uninstall.

With Windows Vista, when you see the User Account Control screen, click
Continue.

4. In the next window, select EPSON Stylus Photo 1400 Series and click OK.
Then follow the on-screen instructions.

5. Restart your computer, then see the Start Here sheet to reinstall your software.

Macintosh

1. Insert the Epson printer software CD-ROM into your Macintosh.
2. Open the Epson CD-ROM desktop icon.
3. Double-click the English folder, then double-click the OSX folder.

Note:
You may have to scroll down to see these folders.

4. Double-click the Installer icon.

5. When the Installer window appears, select Uninstall from the pop-up menu
in the upper left and click Uninstall.

6. Follow the on-screen instructions to uninstall the printer software.

Note:
If the name of your printer remains in the Print Center or Printer Setup Utility,
select it from Printer List and click Delete.

7. Restart your Macintosh, then see the Stars Here sheet to reinstall your
software.
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Where To Get Help

Epson Technical Support

Epson provides these technical support services:

Internet Support

Visit Epson’s support website at epson.com/support and select your product for
solutions to common problems. You can download drivers and documentation,
get FAQs and troubleshooting advice, or e-mail Epson with your questions.

Speak to a Support Representative
Before you call Epson for support, please have the following information ready:

Product name (Epson Stylus Photo 1400)
Product serial number (located on the back of the Epson Stylus Photo 1400)
Proof of purchase (such as a store receipt) and date of purchase

Computer configuration

Description of the problem

Then call:

B U.S.: (562) 276-7282, 6 AM to 8 PM, Pacific Time, Monday through Friday,
and 7 AM to 4 PM, Saturday.

B Canada: (905) 709-2567, 6 AM to 6 PM, Pacific Time, Monday through
Friday.

Toll or long distance charges may apply.

Purchase Supplies and Accessories

You can purchase genuine Epson ink and paper from an Epson authorized reseller.
To find the nearest reseller, call 800-GO-EPSON (800-463-7766). Or you can
purchase online at http://www.epsonstore.com (U.S. sales) or
http://www.epson.ca (Canadian sales).

Where To Get Help 71



Other Software Technical Support

Adobe Photoshop Elements
Telephone: (206) 675-6358

Web: www.adobe.com/support
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Requirements and Notices

Windows System Requirements

To use your printer and its software, your system should have:

B A Microsoft® Windows compatible PC with a Pentium® IIT 800 MHz processor
(Pentium 4 processor, 2 GHz or faster recommended)

B Microsoft Windows 2000, Windows XP, Windows XP Professional x64 Edition, or
Windows Vista

512MB RAM (2GB or more recommended)

300MB free hard disk space (1GB or more recommended)
SVGA monitor with at least a 256 color display

CD or DVD drive for installing the printer software

USB connection requires a computer with preinstalled Windows 2000, Windows XP,
Windows XP Professional x64 Edition, or Windows Vista; a Windows-compliant
USB port (Windows-compliant Hi-Speed USB 2.0 port recommended); and a
shielded USB 2.0 “AB” cable. Using an improperly shielded cable or a USB 1.1 cable
may cause the printer to malfunction.

Macintosh System Requirements

To use your printer and its software, your system should have:

Macintosh PowerPC® G4 733 MHz or faster, or Intel® Core™ processor
Macintosh OS X 10.2.8, or 10.3.9 to 10.4.x

512MB RAM (2GB or more recommended)

300MB free hard disk space (1GB or more recommended)

SVGA monitor with at least a 256 color display

CD or DVD drive for installing the printer software

A buile-in USB port (Hi-Speed USB 2.0 port recommended)

A shielded USB 2.0 “AB” cable. Using an improperly shielded cable or a USB 1.1
cable may cause the printer to malfunction.
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Important Safety Instructions

Before using the printer, read and follow these safety instructions.

Be sure to follow all warnings and instructions marked on the printer.
Use only the type of power source indicated on the printer’s label.

Use only the power cord that comes with the printer. Use of another cord may result
in fire or electric shock.

Place the printer near a wall outlet where the plug can be easily unplugged.
Do not let the power cord become damaged or frayed.

If you use an extension cord with the printer, make sure that the total ampere rating
of the devices plugged into the extension cord does not exceed the cord’s ampere
rating. Also, make sure that the total ampere rating of all devices plugged into the wall
outlet does not exceed the wall outlet’s ampere rating.

Avoid using outlets on the same circuit as photocopiers or air control systems that
regularly switch on and off.

Avoid electrical outlets controlled by wall switches or automatic timers.

Keep the entire computer system away from potential sources of electromagnetic
interference, such as loudspeakers or the base units of cordless telephones.

Avoid locations that are subject to rapid changes in temperature or humidity, shocks
or vibrations, or dust.

Do not place the printer near a radiator, heating vent, or other heat source, or in
strong light or direct sunlight.

Leave enough room around the printer to allow for sufficient ventilation.
Do not block or cover openings in the printer case or insert objects through the slots.

Place the printer on a flat, stable surface that extends beyond the base in all directions.
It will not operate properly if it is tilted at an angle.

Make sure the back of the printer is at least 4 inches (10 cm) away from the wall.
Do not spill liquid on the printer.
Do not put your hand inside the printer or touch the ink cartridges during printing.

Do not use aerosol products that contain flammable gases inside or around this
product. Doing so may cause fire.

Do not move the print head by hand; otherwise, you may damage the printer.

Always turn the printer off using the O power button. When this button is pressed,
the green O power light flashes. Do not unplug the printer or turn off the power to
the outlet until the green O power light stops flashing.
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B Before transporting the printer, make sure that the print head is in the home (far
right) position and the ink cartridges are in place.

B Leave the ink cartridges installed. Removing the cartridges can dehydrate the print
head and may prevent the printer from printing.

B Except as specifically explained in your documentation, do not attempt to service the
printer yourself.

B Unplug the printer and refer servicing to qualified service personnel under the
following conditions: if the power cord or plug is damaged; if liquid has entered the
printer; if the printer has been dropped or the case damaged; if the printer does not
operate normally or exhibits a distinct change in performance. Adjust only those
controls that are covered by the operating instructions.

B When connecting the printer to a computer or other device with a cable, ensure the
correct orientation of the connectors. Each connector has only one correct
orientation. Inserting a connector in the wrong orientation may damage both devices
connected by the cable.

B When storing or transporting the printer, do not tilt it, stand it on its side, or turn it
upside down; otherwise, ink may leak from the cartridges.

Ink Cartridge Safety Instructions

Keep ink cartridges out of the reach of children and do not drink the ink.
B Do not shake ink cartridges after opening their packages; this can cause leakage.

B Be careful when you handle used ink cartridges; there may be ink remaining around
the ink supply port. If ink gets on your skin, wash it off with soap and water. If it gets
in your eyes, flush them immediately with water.

B Do not remove or tear any label or seal on the cartridge other than the yellow tab; this
can cause leakage.

B Install an ink cartridge immediately after you remove it from its package. Leaving the
cartridge unpacked for a long time before using it can result in reduced print quality.

B Do not use an ink cartridge beyond the date printed on the package. For best results,
use up the ink cartridges within six months of first installing them.

B Do not dismantle ink cartridges or try to refill them. This could damage the print

head.

W After bringing an ink cartridge inside from a cold storage site, allow it to warm up at
room temperature for at least three hours before using it.

B Store ink cartridges in a cool, dark place.

B Do not touch the green IC chip on the side of the cartridge. Doing so may prevent
normal operation and printing.

Important Safety Instructions

75



B The IC chip on these ink cartridges retains a variety of cartridge related-information,
such as the ink cartridge status, so that the cartridge may be removed and reinserted
freely. However, each time the cartridge is inserted, some ink is consumed because the
printer automatically performs a reliability check.

B Ifyou remove an ink cartridge for later use, protect the ink supply area from dirt and
dust, and store it in the same environment as the printer. A valve in the ink supply
port makes covers or plugs unnecessary, but the ink may stain items that come into
contact with this area of the cartridge. Do not touch the ink supply port or the
surrounding area.

B Store ink cartridges with their labels facing upward. Do not store cartridges upside
down.

FCC Compliance Statement

For United States Users

This equipment has been tested and found to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference in a residential installation. This
equipment generates, uses, and can radiate radio frequency energy and, if not installed and
used in accordance with the instructions, may cause harmful interference to radio or
television reception. However, there is no guarantee that interference will not occur in a
particular installation. If this equipment does cause interference to radio and television
reception, which can be determined by turning the equipment off and on, the user is
encouraged to try to correct the interference by one or more of the following measures:

B Reorient or relocate the receiving antenna.
B Increase the separation between the equipment and receiver.

B Connect the equipment into an outlet on a circuit different from that to which the
receiver is connected.

B Consult the dealer or an experienced radio/TV technician for help.
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WARNING: The connection of a non-shielded equipment interface cable to this
equipment will invalidate the FCC Certification of this device and may cause interference
levels which exceed the limits established by the FCC for this equipment. It is the
responsibility of the user to obtain and use a shielded equipment interface cable with this
device. If this equipment has more than one interface connector, do not leave cables
connected to unused interfaces. Changes or modifications not expressly approved by the
manufacturer could void the user’s authority to operate the equipment.

For Canadian Users
This Class B digital apparatus complies with Canadian ICES-003.
Cer appareil numérique de la classe B est conforme a la norme NMB-003 du Canada.

Declaration of Conformity

According to 47CFR, Part 2 and 15 for Class B Personal Computers and Peripherals; and/
or CPU Boards and Power Supplies used with Class B Personal Computers:

We: Epson America, Inc.

Located at: MS: 3-13
3840 Kilroy Airport Way
Long Beach, CA 90806-2469
Telephone: (562) 290-5254

Declare under sole responsibility that the product identified herein, complies with 47CFR
Part 2 and 15 of the FCC rules as a Class B digital device. Each product marketed is
identical to the representative unit tested and found to be compliant with the standards.
Records maintained continue to reflect the equipment being produced can be expected to
be within the variation accepted, due to quantity production and testing on a statistical
basis as required by 47CFR §2.909. Operation is subject to the following two conditions:
(1) this device may not cause harmful interference, and (2) this device must accept any
interference received, including interference that may cause undesired operation.

Trade Name: Epson
Type of Product: Ink Jet Printer
Model: B321B
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Epson America, Inc. Limited Warranty

What Is Covered: Epson America, Inc. (“Epson”) warrants to the original retail purchaser
that the Epson printer covered by this limited warranty statement, if purchased and
operated only in the United States or Canada, will be free from defects in workmanship
and materials for a period of one (1) year from the date of original purchase. For warranty
service, you must provide proof of the date of original purchase.

What Epson Will Do To Correct Problems: Should your Epson printer prove defective
during the warranty period, please call the Epson Connection™ at (562) 276-7296 (U.S.)
or (905) 709-2567 (Canada) for warranty repair instructions and return authorization. An
Epson service technician will provide telephone diagnostic service to determine whether
the printer requires service. If service is needed, Epson will, at its option, exchange or
repair the printer without charge for parts or labor. If Epson authorizes an exchange for the
defective unit, Epson will ship a replacement printer to you, freight prepaid, so long as you
use an address in Canada or the U.S. (excluding Puerto Rico and U.S. Possessions).
Shipments to other locations will be made freight collect. You are responsible for securely
packaging the defective unit and returning it to Epson within five (5) working days of
receipt of the replacement. Epson requires a debit or a credit card number to secure the
cost of the replacement printer in the event that you fail to return the defective one. If your
printer is being repaired, Epson will direct you to send your printer to Epson or its
authorized service center, where the printer will be fixed and sent back to you. You are
responsible for packing the printer and for all costs to and from the Epson authorized
service center. When warranty service involves the exchange of the printer or a part, the
item replaced becomes Epson property. The replacement printer or part may be new or
refurbished to the Epson standard of quality, and, at Epson’s option, may be another
model of like kind and quality. Epson’s liability for replacement of the covered printer will
not exceed the original retail selling price of the covered printer. Exchange products and
parts assume the remaining warranty period of your original product covered by this
limited warranty.

What This Warranty Does Not Cover: This warranty does not apply to refurbished or
reconditioned products. This warranty covers only normal use in the United States and
Canada. Using this product for continuous production or similar high duty purposes is
not considered normal use; damage, maintenance or service from such use will not be
covered under this warranty. This warranty is not transferable. This warranty does not
cover any color change or fading of prints or reimbursement of materials or services
required for reprinting. This warranty does not cover damage to the Epson product caused
by parts or supplies not manufactured, distributed or certified by Epson. This warranty
does not cover ribbons, ink cartridges or third party parts, components, or peripheral
devices added to the Epson product after its shipment from Epson, e.g., dealer or user-
added boards or components. Epson is not responsible for warranty service should the
Epson label or logo or the rating label or serial number be removed or should the product
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fail to be properly maintained or fail to function properly as a result of misuse, abuse,
improper installation, neglect, improper shipping, damage caused by disasters such as fire,
flood, and lightning, improper electrical current, software problems, interaction with non-
Epson products, or service other than by an Epson Authorized Servicer. If a claimed defect
cannot be identified or reproduced, you will be held responsible for the costs incurred.

THE WARRANTY AND REMEDY PROVIDED ABOVE ARE EXCLUSIVE AND IN
LIEU OF ALL OTHER EXPRESS OR IMPLIED WARRANTIES INCLUDING, BUT
NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY,
NON-INFRINGEMENT OR FITNESS FOR A PARTICULAR PURPOSE. SOME
LAWS DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES. IF
THESE LAWS APPLY, THEN ALL EXPRESS AND IMPLIED WARRANTIES ARE
LIMITED TO THE WARRANTY PERIOD IDENTIFIED ABOVE. UNLESS
STATED HEREIN, ANY STATEMENT OR REPRESENTATIONS MADE BY ANY
OTHER PERSON OR FIRM ARE VOID. EXCEPT AS PROVIDED IN THIS
WRITTEN WARRANTY, NEITHER EPSON AMERICA, INC. NOR ITS
AFFILIATES SHALL BE LIABLE FOR ANY LOSS, INCONVENIENCE, OR
DAMAGE, INCLUDING DIRECT, SPECIAL, INCIDENTAL OR
CONSEQUENTIAL DAMAGES, RESULTING FROM THE USE OR INABILITY
TO USE THE EPSON PRODUCT, WHETHER RESULTING FROM BREACH OF
WARRANTY OR ANY OTHER LEGAL THEORY.

In Canada, warranties include both warranties and conditions.

Some jurisdictions do not allow limitations on how long an implied warranty lasts, and
some jurisdictions do not allow the exclusion or limitation of incidental or consequential
damages, so the above limitations and exclusions may not apply to you. This warranty
gives you specific legal rights and you may have other rights which vary from jurisdiction
to jurisdiction.

To find the Epson Authorized Reseller nearest you, visit our website at:
htep:/fwww.epson.com.

To find the Epson Customer Care Center nearest you, visit
htep://support.epson.com.

You can also write to:
Epson America, Inc., P.O. Box 93012, Long Beach, CA 90809-3012

Epson America, Inc. Limited Warranty
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Index

A

Accessories, 71
Aligning print head, 53 to 54

Automatic mode, Macintosh, 19

B

Banding, 63

Basic printing
Macintosh, 18 to 21
Windows, 14 to 17

Blank pages, 68

Blurry images, 63

Borderless expansion
Macintosh, 29
Windows, 27

Borderless printing, 23 to 29

C

Cable, USB, 73
Camera/phone, printing from, 42
Cancelling printing
Macintosh, 21
Windows, 17
CDs
adjusting print density, 36 to 37, 41
adjusting print position, 35 to 36, 39 to
40
designing, 33 to 41
feeding problems, 68
inserting in printer, 31 to 32
printing on, 30 to 41
printing problems, 67 to 68
Cell phone, printing from, 42
Characters, incorrect, 69

Checking printer, 59

Cleaning
print head, 44 to 45
printer, 54 to 55
rollers, 30, 66 to 67
sheets, 55, 66 to 67

Color management
Macintosh, 19
Windows, 16

Color problems, 65

ColorSync, 19

Copies setting, Macintosh, 19

D

Declaration of Conformity, 77
Default printer settings, Windows, 17
Digital camera, printing from, 42
Displaying photos, 29

DVDs, see CDs

E

Edge-to-edge printing, 23 to 29
Epson
accessories, 71
help, 71 to 72
ink, 47
paper, 10, 13, 21, 23
Print CD, 33 to 41
Store, 71
warranty, 78 to 79
Expansion, borderless
Macintosh, 29
Windows, 27
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82

F

Faint images, 64
FCC Compliance, 76 to 77
Full bleed printing, 23 to 29

G

Gamma setting, Macintosh, 19
Grainy prints, 65

H

Head Cleaning utility, 44 to 45
Help, Epson, 71 to 72

I

Incorrect characters, 69
Incorrect colors, 65
Incorrect margins, 68
Ink cartridge
ordering, 47
replacing, 46 to 53
safety instructions, 48, 75 to 76
status, 46 to 47
Ink status, checking, 46 to 47
Inverted image, 68

]

Jams, paper, 66 to 67

L

Layout problems, 69
Layout settings
Macintosh, 19
Windows, 16
Lights, status, 57 to 58
Loading paper, 7 to 10

Index

M

Macintosh
basic printing, 18 to 21
borderless printing, 27 to 29
system requirements, 73
uninstalling software, 70
Maintaining printer, 43 to 55
Marginless printing, 23 to 29
Margins, incorrect, 68
Media Type setting, 21
Mirror image, 68
Monitoring ink status, 46 to 47
Moving printer, 55

N

Noise, printer, 62
Nozzle check, 43 to 44

Q)

Orientation setting
Macintosh, 18
Windows, 15

P

Page Setup, Macintosh, 18
Paper
Epson, 10, 13, 21, 23
feeding problems, 65 to 67
loading, 7 to 10
orientation, Macintosh, 18
orientation, Windows, 15
size, Macintosh, 18
size, Windows, 15
Paper Type setting, 21
Phone, printing from, 42
Photos
displaying and storing, 29
printing, 23 to 29



Print head
aligning, 53 to 54
cleaning, 44 to 45

Print Head Alignment utility, 53 to 54

Print quality problems, 63 to 65
Print window
Macintosh, 18
Windows, 14
Printer
check, 59
cleaning, 54 to 55
maintaining, 43 to 55
noise, 62
problems, 61 to 62
transporting, 55
Printing
basic, 14 to 21
borderless photos, 23 to 29
CDs and DVDs, 30 to 41
controlling, Macintosh, 21
controlling, Windows, 17
Printing, slow, 62
Problems
CD printing, 67 to 68
color, 65
installing software, 60 to 61
miscellaneous, 68 to 69
paper feeding, 65 to 67
print quality, 63 to 65
printer, 61 to 62
solving, 57 to 72

Q

Quality Option setting, 15
Quality/Speed setting, 19

R

Rollers, cleaning, 30, 66 to 67

S

Safety instructions, 48, 74 to 76
Service, 71
Slow printing, 62
Software
Epson Print CD, 33 to 41
problems, solving, 60 to 61
uninstalling, 70
Stopping printing
Macintosh, 21
Windows, 17
Storing photos, 29
Support, 71
System requirements, 73

T

Transporting printer, 55
Troubleshooting, 57 to 72
Type setting, 21

U

Uninstalling software, 70
USB
cable, 73
port for camera/phone, 42
Urtilities
Head Cleaning, 44 to 45
Nozzle Check, 43 to 44
Print Head Alignment, 53 to 54

\\4

Warranty, 78 to 79

Windows
basic printing, 14 to 17
borderless printing, 24 to 27
system requirements, 73
uninstalling software, 70
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Epson Paper and Ink—
Designed to Work Together

For the best prints, use genuine Epson paper and ink. You can purchase them online at
www.epsonstore.com (U.S. sales) or www.epson.ca (Canadian sales). You can also
purchase genuine Epson paper and ink from an Epson authorized reseller. To find the
nearest reseller, call 800-GO-EPSON (800-463-7766).

Epson Papers

Epson papers are specially coated to work with genuine Epson inks for optimal image quality
and maximum longevity.

Paper category Description

Photo Papers For lab quality photos—from everyday snapshots to professional
portraits. Available in glossy, semi-gloss, and luster finishes.

Matte Papers Non-glare paper with a smooth or textured finish for professional
quality photos, brochures, or art projects.

Scrapbooking Papers | Acid-free, lignin-free paper for archival quality photos,
backgrounds, headlines, and other page elements.

Fine Art Papers Luxurious weight, texture, and finish give these fine art papers a
true museum quality appearance.

Specialty Papers For projects that showcase your favorite photos, including greeting
cards, iron-on transfers, and transparencies.

See the inside back cover for a list of just some of the Epson paper types
and sizes you can use with the Epson Stylus Photo 1400. See your
User’s Guide for a complete list of compatible Epson papers.

Genuine Epson Inks

Look for the number below to find your cartridges.
It's as easy as remembering your number!

@ Black T079120 @ Magenta T079320

@ Cyan T079220 _j:‘) Lt. Magenta T079620

7/ ) Lt Cyan T079520 /) Yellow T079420




Paper name

Size

Part number

Epson Ultra Premium Photo Paper Glossy Borderless 4 x 6 inches S041934
Epson Ultra Premium Glossy Photo Paper Letter (8.5 x 11 inches) S041935
Epson Premium Photo Paper Glossy Borderless 4 x 6 inches S041808
Epson Premium Glossy Photo Paper S041727
Borderless 5 x 7 inches S041464

Borderless 8 x 10 inches S041465

Letter (8.5 x 11 inches) S041286

S041667

Borderless 11 x 14 inches S041466

US B (11 x 17 inches) S041290

A3 (11.7 x 16.5 inches) S041288

Super B (13 x 19 inches) S041289

Epson Premium Photo Paper Semi-gloss Borderless 4 x 6 inches S041982
Epson Premium Semigloss Photo Paper Letter (8.5 x 11 inches) S041331
Super B (13 x 19 inches) S041327

Epson Photo Paper Glossy Borderless 4 x 6 inches S041809
Epson Glossy Photo Paper S042038
S041134

S041671

Letter (8.5 x 11 inches) S041141

S041649

S041271

S041272

US B (11 x 17 inches) S041156

Super B (13 x 19 inches) S041143

Epson Premium Presentation Paper Matte Borderless 8 x 10 inches S041467
Epson Matte Paper Heavyweight Letter (8.5 x 11 inches) S041257
Borderless 11 x 14 inches S041468

A3 (11.7 x 16.5 inches) S041260

Super B (13 x 19 inches) S041263

Epson Ultra Premium Presentation Paper Matte Letter (8.5 x 11 inches) S041341
Epson Enhanced Matte Paper A3 (11.7 x 16.5 inches) S041343
Super B (13 x 19 inches) S041339

Epson Presentation Paper Matte Letter (8.5 x 11 inches) S041062
Epson Photo Quality Ink Jet Paper Legal (8.5 x 14 inches) S041067
US B (11 x 17 inches) S041070

Super B (13 x 19 inches) S041069

Epson Ultra Premium Photo Paper Luster Letter (8.5 x 11 inches) S041405
Epson Premium Luster Photo Paper A3 (11.7 x 16.5 inches) S041406
Super B (13 x 19 inches) S041407

S041604




	Front Matter
	Copyright Notice
	Trademarks

	Contents
	Welcome
	Exif Print
	About Your Documentation

	Printing from Start to Finish
	Loading Paper
	Special Papers

	Printing with Windows
	Selecting Default Settings

	Printing with a Macintosh
	Selecting the Correct Paper Type
	Printing Borderless Photos
	Borderless Printing with Windows
	Borderless Printing with a Macintosh
	Storing and Displaying Your Prints

	Printing on CDs and DVDs
	Cleaning the Rollers
	Inserting a CD or DVD
	Designing and Printing a CD/DVD with Windows
	Designing and Printing a CD/DVD with a Macintosh

	Direct Printing from a Digital Camera or Camera Phone

	Maintaining Your Printer
	Checking the Print Head Nozzles
	Cleaning the Print Head
	Replacing an Ink Cartridge
	Checking the Ink Status
	Purchasing Ink Cartridges
	Ink Cartridge Precautions
	Removing and Installing Ink Cartridges

	Aligning the Print Head
	Cleaning the Printer
	Transporting the Printer

	Solving Problems
	Diagnosing Printer Problems
	Running a Printer Check

	Problems and Solutions
	Setup and Software Installation Problems
	Printer Problems
	Print Quality Problems
	Problems with Paper Feeding
	CD/DVD Printing Problems
	Miscellaneous Printout Problems

	Uninstalling Printer Software
	Windows
	Macintosh

	Where To Get Help
	Epson Technical Support
	Purchase Supplies and Accessories
	Other Software Technical Support


	Requirements and Notices
	Windows System Requirements
	Macintosh System Requirements
	Important Safety Instructions
	Ink Cartridge Safety Instructions

	FCC Compliance Statement
	Declaration of Conformity
	Epson America, Inc. Limited Warranty

	Index
	Epson Paper and Ink—Designed to Work Together

